AVAYA

Deploying IP Office as an Avaya Cloud
Office ATA Gateway

Release 12.1
Issue 6
January 2025



Notices
© 2026 Avaya LLC. All Rights Reserved.

You may, at your own risk, assemble a MyDocs collection solely for your own internal business
purposes, which constitutes a modification to the original published version of the publications.
Avaya shall not be responsible for any modifications, additions, or deletions to the original
published version of publications. You agree to defend, indemnify and hold harmless Avaya,
Avaya's agents, servants and employees against all claims, lawsuits, demands and judgments
arising out of, or in connection with, your modifications, additions or deletions to the
publications.

A single topic or a collection of topics may come from multiple Avaya publications. All of the
content in your collection is subject to the legal notices and disclaimers in the publications from
which you assembled the collection. For information on licenses and license types,
trademarks, and regulatory statements, see the original publications from which you copied the
topics in your collection.

Except where expressly stated by Avaya otherwise, no use should be made of materials
provided by Avaya on this site. All content on this site and the publications provided by Avaya
including the selection, arrangement and design of the content is owned by Avaya and/or its
licensors and is protected by copyright and other intellectual property laws including the sui
generis rights relating to the protection of databases. Avaya owns all right, title and interest to
any modifications, additions or deletions to the content in the Avaya publications.

May 11, 2026 Legal



©2022-2025, Avaya LLC
All Rights Reserved.

Notice

While reasonable efforts have been made to ensure that the
information in this document is complete and accurate at the time

of printing, Avaya assumes no liability for any errors. Avaya reserves
the right to make changes and corrections to the information in this
document without the obligation to notify any person or organization
of such changes.

Documentation disclaimer

“Documentation” means information published in varying media
which may include product information, subscription or service
descriptions, operating instructions and performance specifications
that are generally made available to users of products.
Documentation does not include marketing materials. Avaya shall
not be responsible for any modifications, additions, or deletions

to the original published version of Documentation unless such
modifications, additions, or deletions were performed by or on the
express behalf of Avaya. End user agrees to indemnify and hold
harmless Avaya, Avaya's agents, servants and employees against
all claims, lawsuits, demands and judgments arising out of, or in
connection with, subsequent modifications, additions or deletions to
this documentation, to the extent made by End user.

Link disclaimer

Avaya is not responsible for the contents or reliability of any linked
websites referenced within this site or Documentation provided by
Avaya. Avaya is not responsible for the accuracy of any information,
statement or content provided on these sites and does not
necessarily endorse the products, services, or information described
or offered within them. Avaya does not guarantee that these links will
work all the time and has no control over the availability of the linked
pages.

Warranty

Avaya provides a limited warranty on Avaya hardware and software.
Please refer to your agreement with Avaya to establish the terms of
the limited warranty. In addition, Avaya’s standard warranty language
as well as information regarding support for this product while under
warranty is available to Avaya customers and other parties through
the Avaya Support website: https://support.avaya.com/helpcenter/
getGenericDetails?detailld=C20091120112456651010 under the link
“Warranty & Product Lifecycle” or such successor site as designated
by Avaya. Please note that if the product(s) was purchased from an
authorized Avaya channel partner outside of the United States and
Canada, the warranty is provided by said Avaya Channel Partner and
not by Avaya.

“Hosted Service” means an Avaya hosted service subscription that
You acquire from either Avaya or an authorized Avaya Channel
Partner (as applicable) and which is described further in Hosted SAS
or other service description documentation regarding the applicable
hosted service. If You purchase a Hosted Service subscription,

the foregoing limited warranty may not apply but You may be

entitled to support services in connection with the Hosted Service

as described further in your service description documents for the
applicable Hosted Service. Contact Avaya or Avaya Channel Partner
(as applicable) for more information.

Hosted Service

THE FOLLOWING APPLIES ONLY IF YOU PURCHASE AN

AVAYA HOSTED SERVICE SUBSCRIPTION FROM AVAYA OR

AN AVAYA CHANNEL PARTNER (AS APPLICABLE), THE TERMS
OF USE FOR HOSTED SERVICES ARE AVAILABLE ON THE
AVAYA WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO
UNDER THE LINK “Avaya Terms of Use for Hosted Services”

OR SUCH SUCCESSOR SITE AS DESIGNATED BY AVAYA, AND
ARE APPLICABLE TO ANYONE WHO ACCESSES OR USES THE
HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED
SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON
BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE
DOING SO (HEREINAFTER REFERRED TO INTERCHANGEABLY
AS “YOU” AND “END USER”), AGREE TO THE TERMS OF USE.
IF YOU ARE ACCEPTING THE TERMS OF USE ON BEHALF A
COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT THAT
YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THESE

TERMS OF USE. IF YOU DO NOT HAVE SUCH AUTHORITY,

OR IF YOU DO NOT WISH TO ACCEPT THESE TERMS OF

USE, YOU MUST NOT ACCESS OR USE THE HOSTED SERVICE
OR AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED
SERVICE.

Licenses

The Global Software License Terms (“Software License Terms”)

are available on the following website https://www.avaya.com/en/
legal-license-terms/ or any successor site as designated by Avaya.
These Software License Terms are applicable to anyone who
installs, downloads, and/or uses Software and/or Documentation. By
installing, downloading or using the Software, or authorizing others to
do so, the end user agrees that the Software License Terms create
a binding contract between them and Avaya. In case the end user is
accepting these Software License Terms on behalf of a company or
other legal entity, the end user represents that it has the authority to
bind such entity to these Software License Terms.

Copyright

Except where expressly stated otherwise, no use should be made
of materials on this site, the Documentation, Software, Hosted
Service, or hardware provided by Avaya. All content on this site, the
documentation, Hosted Service, and the product provided by Avaya
including the selection, arrangement and design of the content is
owned either by Avaya or its licensors and is protected by copyright
and other intellectual property laws including the sui generis rights
relating to the protection of databases. You may not modify, copy,
reproduce, republish, upload, post, transmit or distribute in any way
any content, in whole or in part, including any code and software
unless expressly authorized by Avaya. Unauthorized reproduction,
transmission, dissemination, storage, or use without the express
written consent of Avaya can be a criminal, as well as a civil offense
under the applicable law.

Virtualization

The following applies if the product is deployed on a virtual machine.
Each product has its own ordering code and license types. Unless
otherwise stated, each Instance of a product must be separately
licensed and ordered. For example, if the end user customer or
Avaya Channel Partner would like to install two Instances of the
same type of products, then two products of that type must be
ordered.

Third Party Components

The following applies only if the H.264 (AVC) codec is distributed
with the product. THIS PRODUCT IS LICENSED UNDER THE AVC
PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A
CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE

IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE.
ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA,
L.L.C. SEE HTTP://WWW.MPEGLA.COM.

Service Provider

WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL
PARTNER IS HOSTING ANY PRODUCTS THAT USE OR

EMBED THE H.264 CODEC OR H.265 CODEC, THE AVAYA
CHANNEL PARTNER ACKNOWLEDGES AND AGREES THE
AVAYA CHANNEL PARTNER IS RESPONSIBLE FOR ANY AND
ALL RELATED FEES AND/OR ROYALTIES. THE H.264 (AVC)
CODEC IS LICENSED UNDER THE AVC PATENT PORTFOLIO
LICENSE FOR THE PERSONAL USE OF A CONSUMER

OR OTHER USES IN WHICH IT DOES NOT RECEIVE
REMUNERATION TO: (i) ENCODE VIDEO IN COMPLIANCE WITH
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE

IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE.
ADDITIONAL INFORMATION FOR H.264 (AVC) ANDH 3 (HEVC)
CODECS MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://
WWW.MPEGLA.COM.
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Compliance with Laws

You acknowledge and agree that it is Your responsibility to comply
with any applicable laws and regulations, including, but not limited
to laws and regulations related to call recording, data privacy,
intellectual property, trade secret, fraud, and music performance
rights, in the country or territory where the Avaya product is used.

Preventing Toll Fraud

“Toll Fraud” is the unauthorized use of your telecommunications
system by an unauthorized party (for example, a person who is not a
corporate employee, agent, subcontractor, or is not working on your
company's behalf). Be aware that there can be a risk of Toll Fraud
associated with your system and that, if Toll Fraud occurs, it can
result in substantial additional charges for your telecommunications
services.

Avaya Toll Fraud intervention

If You suspect that You are being victimized by Toll Fraud and You
need technical assistance or support, please contact your Avaya
Sales Representative.

Security Vulnerabilities

Information about Avaya’s security support policies can be
found in the Security Policies and Support section of https://
support.avaya.com/security.

Suspected Avaya product security vulnerabilities are handled
per the Avaya Product Security Support Flow (https://
support.avaya.com/css/P8/documents/100161515).

Trademarks

The trademarks, logos and service marks (“Marks”) displayed in this
site, the Documentation, Hosted Service(s), and product(s) provided
by Avaya are the registered or unregistered Marks of Avaya, its
affiliates, its licensors, its suppliers, or other third parties. Users

are not permitted to use such Marks without prior written consent
from Avaya or such third party which may own the Mark. Nothing
contained in this site, the Documentation, Hosted Service(s) and
product(s) should be construed as granting, by implication, estoppel,
or otherwise, any license or right in and to the Marks without the
express written permission of Avaya or the applicable third party.

Avaya is a registered trademark of Avaya LLC.
All non-Avaya trademarks are the property of their respective owners.

Linux® is the registered trademark of Linus Torvalds in the U.S. and
other countries.

Downloading Documentation

For the most current versions of Documentation, see the Avaya
Support website: https://support.avaya.com, or such successor site
as designated by Avaya.

Contact Avaya Support

See the Avaya Support website: https://support.avaya.com for
Product or Cloud Service notices and articles, or to report a

problem with your Avaya Product or Cloud Service. For a list of
support telephone numbers and contact addresses, go to the Avaya
Support website: https://support.avaya.com (or such successor site
as designated by Avaya), scroll to the bottom of the page, and select
Contact Avaya Support.
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Chapter 1: Deploying IP Office as an Avaya
Cloud Office™ ATA gateway

For IP Office R11.1.2.3 and higher, you can configure an IP500 V2A to act as an Analog Terminal
Adapter (ATA) for analog ex’ggnsions connecting to Avaya Cloud OffigMe . In this mode, the IP Office
uses an Avaya Cloud Office ~ trunk to connect to Avaya Cloud Office .

Internet Avaya Cloud
Customer Office
Firewall/SBC
Analog
Extension
Local Emergency
Line (Optional)
Local PSAP

« Avaya only supports using an |IP Office as an Avaya Cloud Office™ gateway with IP500 V2A
control units running IP Office R11.1.2.3 or higher.

* Depending on the iQMstaIIed IP Office hardware, up to 376 analog extensions can connect to
Avaya Cloud Office ~ with a maximum of 40 simultaneous calls.

« Emergency calls use the Avaya Cloud Office™ emergency service or a local IP Office trunk
(analog, PRI, or BRI).
Related links
Supported IP Office features on page 7
Calls and call capacity on page 7
IP Office licenses on page 8
IP Office hardware on page 8
Resilience on page 10
Call flow schematics on page 10
Other phones and extensions on page 13
Codecs on page 13

January 2025 Deploying IP Office as an Avaya Cloud Office ATA Gateway
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Supported IP Office features

Ports and protocols on page 13
Glossary on page 14

Supported IP Office features

When using an IP Office system to support Avaya Cloud Office™ extensions, Avaya only supports
the IP Office features detailed in this document. Enabling other features will cause unexpected or
incorrect operation.

» Supported on IP Office IP500 V2A control units running IP Office R11.1.2.3 or higher.
* The solution supports up to 376 analog extensions.

* The solution uses SRTP for media security. This limits the maximum number of simultaneous
calls to 40.

« The solution uses an ACO line to connect to Avaya Cloud Office™.

» The solution uses VCM channels for each current call. This requires the installation of VCM
hardware.

« If not using the Avaya Cloud Office™ E911 emergency call service, the solution must use a
local IP Office trunk for emergency calls

» The solution support fax calls using an analog extension (see Fax configuration on
page 40).

Related links
Deploying IP Office as an Avaya Cloud Office ATA gateway on page 6

Calls and call capacity

This solution supports up to 40 simultaneous calls between Avaya Cloud Office™ and IP Office
analog extensions. Each call uses the following IP Office resources:

Resource Description
Required per Call

An IP Office Each analog extension requires an analog extension port on the IP Office system.
Analog extension | The IP Office provides analog extension ports using base cards installed in the
IP500 V2A control unit and/or external expansion modules attached to the control
unit. See |P _Office hardware on page 8.

An IP Office VCM | The IP Office system uses VCM channels to convert audio between the analog
Channel extension and the ACO line. Each simultaneous call uses 1 VCM channel during the
call.

The IP Office provides VCM channels using hardware installed in the IP500 V2A
control unit. See |P Office hardware on page 8.

January 2025 Deploying IP Office as an Avaya Cloud Office ATA Gateway 8
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Deploying IP Office as an Avaya Cloud Office™ ATA gateway

Related links

Deploying IP Office as an Avaya Cloud Office ATA gateway on page 6

IP Office licenses

Deploying an IP Office system as an ACO ATA gateway does not require any IP Office licenses.
Instead, configured an IP Office as an ACO ATA gateway causes the generation of the two virtual
licenses detailed below.

For any system configured to run in this mode, all licenses present in the system configuration
except those listed below, become dormant.

Type

Description

Virtual Licenses

Initial configuration as an ACO ATA gateway automatically adds the following virtual
licenses to the IP Office system:

+ ACO System
« ACO User

Optional Licenses

By default, the IP Office system supports 8 call channels for each installed PRI
port without requiring any licenses. If using a PRI trunk as a local emergency trunk,
you only need this license if you want to enable additional call channels up to the
maximum capacity of PRI ports installed and PRI mode selected.

+ IP500 Universal PRI (Additional channels)

Related links

Deploying IP Office as an Avaya Cloud Office ATA gateway on page 6

IP Office hardware

The IP Office system supports up to 376 analog extensions connected to Avaya Cloud Office™
using the following hardware:

Description

Control Unit

Avaya supports IP Office ACO ATA Gateway mode on IP500 V2A control units.

Avaya IP Office
System SD Card

The IP Office uses the card's serial number to check its licenses.

January 2025
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IP Office hardware

Description

Analog Extension
Ports

IP Office ACO ATA Gateway mode supports up to 376 analog extension ports:
» IP500 Analog Phone Cards

These base cards provide either 2 or 8 analog extension ports depending on the
card model.

* IP500 ATM Combination Cards

Each of these base cards provides a combination of 6 digital extensions ports, 2
analog extension ports, 4 analog trunk ports and 10 VCM channels. You can install
a maximum of 2 ATM combination cards. The solution does not support the digital
extension ports.

* IP400 Phone V2 External Expansion Modules

Each of these external expansion modules supports 16 or 30 analog extension
ports depending on the module model.

VCM Channels

The IP Office system uses VCM channels to convert audio between the analog
extensions and the ACO line. Each current call requires a VCM channel (up to the
40 simultaneous calls supported by this solution). The IP500 V2A supports up to 148
VCM channels using the following IP500 base cards.

* IP500 ATM Combination Cards
Each combination card provides 10 VCM channels.
* IP500 VCM Cards

These base cards provide 32 or 64 VCM channels depending on the card model.
Note that the codec used also affects the maximum number of channels the

card supports. The default IP500 V2A system codec is G.711. You can install a
maximum of 2 VCM base cards.

Codec IP500 VCM 32 IP500 VCM 64
G.711 A-Law 32 64
G.711 U-Law 32 64
G.729ab 30 60
G.722 30 60

Optional
Hardware

¢ Local Trunk

You can use an analog, BRI or PRI trunk to support local routing of emergency
calls. For analog or PRI trunks, you can use any current IP500 V2A trunk card or
external expansion module.

* 4-Port Expansion Card

You can use this base card to increase the number of supported external
expansion modules to 12 (8 otherwise).

Additional Hardware Information

For additional information, refer to the Deploying an IP500 V2 IP Office Essential Edition System

manual.

January 2025
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Deploying IP Office as an Avaya Cloud Office™ ATA gateway

Related links
Deploying IP Office as an Avaya Cloud Office ATA gateway on page 6

Resilience

For calls between IP Office and Avaya Cloud Office™ there is no IP Office resilience support.

Scenario Description

ACO Line The IP Office will continue attempting to register the extensions with Avaya Cloud

connection not Office™ until successful.

available C ) . T
When in this state, the IP Office system still supports emergency calls if using a local
trunk.

IP Office power If using a local analog trunk for emergency calls, depending on the IP Office

failure hardware, some analog extensions can still make emergency calls. See |P_Office

power fail operation on page 16.

Related links
Deploying IP Office as an Avaya Cloud Office ATA gateway on page 6

Call flow schematics

The following schematics show the call flow and configuration with the IP Office for calls to/from
Avaya Cloud Office™.

Call flow using a local emergency line

This schematic shows a simplified example of the IP Office call flow for calls to/from the Avaya
Cloud Office "when using a local IP Office line for emergency calls.

January 2025 Deploying IP Office as an Avaya Cloud Office ATA Gateway 11
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Call flow schematics

| Exemion | incomine Cal Foute

Base Extension: 15554863874 Line Group 1D 17

. 4 Destination: .
ACO User
Mame: 15554869874 ACO Line

Authentication Name: 801641000000 Line Number: 17

Password: «*=====*

ACOQ Domain Mame: sip.ringcentral.com

Extension: 15554869874 ACO Proxy Address: sip30.ringcentral.com

Profile: ACO User ~— Qutgoing Group ID: 36666

System Short Codes

System Short Code

Code: 7

Avaya Cloud Office

Feature: Dizl
Telephone Number: .
Line Group ID: 50

'

ARS Route Id:50

ARS Short Code

Extension: 200 & n
Code: ¥

Ring Mode: Collective
Feature: Dizl

User List: ...
Telephone Number: .

Line Group ID: 26666 —_— Inmmlng Call Route

Line Group ID: 0
ARS Short Code

Destination: 200 —
Code: 811
Feature: Dial Emergency

Emergency Line
Telephone Mumber: 311 Incoming Group: 0

Line Group ID: O —® Qutgoing Group: 0 Emergency PSAP

Call flow using the ACO E911 emergency service

This schematic shows a simplified example of the IP Office call flow for calls to/from the Avaya
Cloud Office "when using the ACO E911 emergency service for emergency calls.

January 2025 Deploying IP Office as an Avaya Cloud Office ATA Gateway
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Deploying IP Office as an Avaya Cloud Office™ ATA gateway

Base Extension: 15554869874

Line Group ID: 17
==
Tep——

Authentication Name: 801641000000 Line Number: 17

-

Passwaord: =*=**=** ACOQ Domain Mame: sip.ringcentral.com
Extension: 15554869874 ACO Proxy Address: sip30.ringcentral.com Avaya Cloud Office
Profile: ACO User — Qutgoing Group ID: 96666

A

System Short Codes Emergency PSAP

System Short Code

||*_

Code: ¥

Feature: Dial
Telephone Number: .
Line Group ID: 50

H

ARS Route Id: 50

ARS Short Code

Code: ?
Feature: Dizl

Telephone Number: .

Line Group ID: 36666 —

ARS Short Code
Code: 911

Feature: Dial Emergency
Telephone Number: 311

Line Group ID: 36666

Related links
Deploying IP Office as an Avaya Cloud Office ATA gateway on page 6
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Other phones and extensions

Other phones and extensions

This solution only supports analog extensions connecting to Avaya Cloud Office™.

« If the IP Office hardware used includes non-analog extension ports, Avaya does not support
the use of those additional ports.

- You must clearly label the additional extension ports as non-functional.

- You must remove any user records created in the IP Office configuration for the non-ACO
extensions.

- Note: The system automatically creates extension records for all physical extension ports.
Even if you remove these, the system automatically recreates them after any system
restart.

» Other IP phones, including Avaya phones, can connect from the customer site to Avaya
Cloud Office™ directly. The provisioning and operation of those phones is separate from the
IP Office.

Related links
Deploying IP Office as an Avaya Cloud Office ATA gateway on page 6

Codecs

The following codecs are supported for connections between IP Office and Avaya Cloud Office™.
For the IP Office system, these are provided by the installed VCM resources. See IP Office
Hardware on page 8.

* G.711 A-Law
* G.711 U-Law
+ G.722

* G.729ab

Related links
Deploying IP Office as an Avaya Cloud Office ATA gateway on page 6

Ports and protocols

The document https://support.avaya.com/public/index?page=content&id=DOCS100741 provides a
summary for phones and softphones connecting to Avaya Cloud Office . For analog extensions

connecting through IP Office, the IP Office ACO line connects the analog extension using secure
RTP.
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Deploying IP Office as an Avaya Cloud Office™ ATA gateway

Outbound traffic

Traffic Type Protocol Destination Port
Media - Secure SRTP/UDP 20000 to 64999
Signaling - Secure SIP/TLS/TCP 5096

Inbound traffic
Traffic Type Protocol Destination Port
Media - Secure SRTP/UDP 20000 to 64999
Signaling - Secure SIP/TLS/TCP 5060

Related links

Deploying IP Office as an Avaya Cloud Office ATA gateway on page 6

Glossary

Abbreviation Definition
ARS Automatic Route Selection
An IP Office ARS entry is a set of short codes used to set which telephone line or
lines the system should use to route calls.
ATA Analog Terminal Adaptor
A device that allows an analog telephone to connect to a non-analog port. In this
case, the IP Office is acting as an ATA for multiple analog extensions to connect to
Avaya Cloud Office ™.
FXS Foreign Exchange Service
A term for scenarios where one telephone system supports extensions on another
telephone system as if those extensions are local to itself. In this case, Avaya
Cloud Office™ supports IP Office extensions as if directly connected to Avaya Cloud
Office™.
PSAP Public Service Access Point
The service to which calls to emergency numbers connect. The PSAP responder
relays information as needed to the relevant emergency service. That information
can include any address information held by the PSAP for the telephone number
from which the emergency call originated.
Related links

Deploying IP Office as an Avaya Cloud Office ATA gateway on page 6
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Chapter 2: Emergency call support options

The customer solution must support emergency calls. The options are:
« Routing emergency calls to the E911 service available from Avaya Cloud Office™.
» Using a local IP Office trunk for emergency calls.

Related links
Using the Avaya Cloud Office E911 emergency service on page 15
Local IP Office emergency trunk call routing on page 16
IP_Office power fail operation on page 16
Testing emergency call operation on page 16

Using the Avaya Cloud Office E911 emergency service

If not lTJMsing a local IP Office trunk for emergency calls, the IP Office must use the Avaya Cloud
Office” E911 Emergency service for emergency calls. When using that service:

+ The customer must comply with the Avaya Cloud Office™ Emergency Calling Policy. See
https://www.ringcentral.com/legal/last-update-may-31-2022/emergency-services.html.

» Users must configure and maintain their correct address details. See https://
onecare.avaya.com/AvayaCloudOffice/kb/public/DOCS100485.
A Warning:
Certain events, including the following, can prevent you from reaching emergency services:

* An Internet or power outage.
* If your broadband, ISP, or IP telephony services are suspended or terminated.

. Suppomse you are in a country other than the one in which your IP line to Avaya Cloud
Office ~ is provided. For example, if you have a US line and travel to the UK, you cannot
reach the UK emergency services number.

» Suppose you are in a country where RingCentral is not permitted or cannot complete
emergency calls.

* If there is network congestion that delays or prevents completion of calls to the
emergency services.

Related links
Emergency call support options on page 15
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Emergency call support options

Local IP Office emergency trunk call routing

If not using the Avaya Cloud Office™ emergency service, the IP Office must support emergency
calls using a local IP Office trunk. For an IP Office connected to Avaya Cloud Office™, Avaya
supports local trunk emergency calls using an analog, PRI, or BRI trunk.
For more information on IP Office emergency call operation, see the IP_Office Emergency Call
Configuration manual.

Related links
Emergency call support options on page 15

IP Office power fail operation

When using a local analog trunk for emergency calls, IP Office IP500 V2A systems support

options for power failure scenarios. These enable some analog extensions to connect to the
analog trunks to make emergency calls. See the Deploying an IP500 V2 IP Office Essential
Edition System manual.

Related links
Emergency call support options on page 15

Testing emergency call operation

You must test emergency call operation following local laws and regulations. In some locations,
making calls to the Public Service Access Point (PSAP) when there is no emergency is illegal.

« If the PSAP allows test calls using the emergency call numbers, do not end the calls without
informing the PSAP responder that the call is a test.

* Some PSAP providers support an emergency call test number. When called, an automated
response announces the address the PSAP has on record for the calling number. Where
supported, configure the test number in the IP Office configuration to use the same call
routing as the emergency numbers.

- The Avaya Cloud Office™ E911 emergency service supports using 933 as an emergency
call test number.

Related links
Emergency call support options on page 15
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Chapter 3: Obtaining Avaya Cloud Office™
details

To configure the IP Office, you need to obtain a range of information from Avaya Cloud Office ™.

Related links
Setting up the ACO user phone details on page 17
Downloading the ACO certificates on page 19

Setting up the ACO user phone details
The configuration of the IP Office ACO line requires details provided by Avaya Cloud Office™.
Procedure

1. As a system administrator, login to Avaya Cloud Office™ at https://
service.cloudoffice.avaya.com.

2. Select Phone System > Phones & Devices > User Phones.

3. Within the Avaya Cloud Office™ administration menus, setup the Avaya Cloud Office™
user's phone.

4. Click the Existing Phone link next to the required user.

5. Click Setup & Provision.

Home Users Phone system Meetings Reporis v Billing Mare a 0. G

< Back Existing phone

Device Name O

\ Existing phone
kh Existing phone

Change phone Resync

Serial number: N/A ©
Assigned type: User phone

Status: Online

6. In the Select device menu, select Other phones.
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Obtaining Avaya Cloud Office™ details

January 2025

Setup & provision ®

1 Select device 2 Provisioning 3 Finish

In addition to the devices Avaya Cloud Office sells pre-provisioned, Avaya Cloud Office supports assisted provisioning for additional models. If your model is not available via assisted provisioning, Avaya
Cloud Office may have documented how to manually configure it. Please see the office devices page for more information

Select your phone model to begin

Avaya IP Phones CiscoiLinksys IP devices Polycom IP phones Yealink IP phones
Avaya B199 Avaya J139 Avaya J159 Avaya J169
' Select j Select ﬁ Select j Select
Under Existing Phone, click Select.

Setup & provision x

1 Select device 2 Provisioning 3 Finish

In addition to the devices Avaya Cloud Office sells pre-provisioned, Avaya Cloud Office supports assisted provisioning for additional models. If your model is not available via assisted provisioning, Avaya
Cloud Office may have documented how to manually configure it. Please see the office devices page for more information

Select your phone model to begin
Avaya IP Phones Cisco/Linksys IP devices Polycom IP phenes Yealink IP phones Other phones

Existing phone

\‘ = || Select

In the Provisioning menu, set Will you be using secure voice transport on this
device? to Yes.

Setup & provision x
~ Select device + Provisioning 3 Finish
Manual Provisioning

To connect your device with Avaya Cloud Office services, set up your device following the steps below. Configuration for each device may vary, please check with your
device’s manufacturer for specific instructions.

T Copy

Step 1: Will you be using secure voice transport on this device?

I ® Yes — The device must support Transport Protocol version TLS 1.2 Learn More I
O No

Step 2: Configure SIP information

Field Value

SIP domain sip.ringcentral.com:5060

Remote SIP port 5060

Local SIP port 5060

Qutbound proxy sip30.ringcentral.com:5096 v
Qutbound proxy port 5096

Username 16554869874

Password c4dmJdAAA

Authorisation 1D 801641000000

Note the settings. You can use the Copy button to copy the details into a document. Whilst
the line settings are the same for each user, the user/extension values are different for
each user.

ACO Value IP Office Line Value

SIP Domain ACO Line > ACO > ACO Domain Name without the port number.

Outbound proxy | ACO Line > ACO > ACO Proxy Address without the port number.
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Downloading the ACO certificates

ACO Value IP Office User/Extension Value

Username User > User > User Name
User > User > Extension

Extension > Extension > Base Extension

Password User > User > Password

Authorization ID | User > User > Authentication Name

10. Click Done.
Next steps
* Go to Downloading the ACO certificates on page 19.

Related links
Obtaining Avaya Cloud Office details on page 17

Downloading the ACO certificates

The connection between the IP Office and Avaya Cloud Office™ use SRTP and TLS. To support

both, you need to obtain two certificates from Avaya Cloud Office™.

Procedure

1. Using the following links, download the two certificates:

Certificate Source

Intermediate Certificate | https://www.websecurity.symantec.com/content/dam/websitesecurity/support/

digicert/thawte/ica/Thawte EV_RSA CA 2018.pem

Root Certificate https://www.websecurity.symantec.com/content/dam/websitesecurity/support/

digicert/thawte/root/DigiCertHighAssuranceEVRootCA.pem

2. Save the certificate files.
Next steps
» Go to Configuring the IP Office system on page 20.

Related links
Obtaining Avaya Cloud Office details on page 17
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Chapter 4: Configuring the IP Office system

The processes in this section prepare the IP Office system for the configuration of the Avaya Cloud
Office™ user extensions.

» This document does not cover the configuration of other equipment such as the customer
network, firewalls, and any SBC equipment.

Related links
Prerequisites on page 20
Running the initial IP Office configuration utility on page 21
Adding IP Office licenses on page 23
Adding the ACO certificates on page 24
Configuring the local lines on page 25
Adding the ACOQ line on page 25
Edit the system short codes on page 27
Edit the outgoing automatic call route selection (ARS) on page 28
Create a PSAP callback hunt group on page 29

Prerequisites

Ensure that you have the following prerequisites:

+ Avaya Cloud Office™ user details. See Setting up the ACO user phone details on page 17.

+ Avaya Cloud Office™ certificate files. See Downloading the ACO certificates on page 19.

« |P Office license file including:
- An ACO System for the system.
- An ACO User instance for each Avaya Cloud Office™ analog extension user.

- If using a local PRI trunk as the emergency line, the license file may also need an IP500
Universal PRI (Additional channels) license.

Next

» Assemble and install the IP Office hardware using the details in the Deploying an IP500 V2
IP Office Essential Edition System manual.

* When complete, go to Running the initial IP_Office configuration utility on page 21.
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Running the initial IP Office configuration utility

Related links
Configuring the IP Office system on page 20

Running the initial IP Office configuration utility

This process runs the initial configuration menu on the IP500 V2A control unit.

A Warning:

* Running this process on an existing system erases the existing configuration and ends
all current calls and services.

Procedure
1. Load the IP Office configuration in IP Office Manager.

a. On an existing IP Office system: If using IP Office Manager, click File > Initial
Configuration. If using IP Office Web Manager, select Solution > Actions > Initial
Configuration. Click OK.

b. On a new system: Set and note the new values for the system passwords.

January 2025 Deploying IP Office as an Avaya Cloud Office ATA Gateway 22

Comments on this document?



https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DeployingIPOfficeasanAvayaCloudOfficeATAGateway&p3=6

Configuring the IP Office system

2. In the initial configuration menu:

] HAvaya IP Office Initial Configuration

System Mode IP Office ACO ATA Gateway w
System Mame |S'_.'stem B

Retain Configuration Data ] |

Locale United States (US English

Default Extension Password |uuu"" |

Corfimn Default Extension Password |"uu"u |

Public LAN Interface (®) LAN1 () LANZ
IP Address 192168 . 0 . 36 | [] Enable NAT
IP Magk 255 .2535.255. 0
Gateway 0 i o .0
DHCP Mode
() Server () Cliert () Dialln (®) Disabled
DMS Server 192 . 168. 0 . 50

lUnder Centralized Management # ]
Save Beset Close Help

a. Set the System Mode to IP Office ACO ATA Gateway.
b. Deselect Retain existing configuration.

c. Configure the settings to match the customer's locale and network. Note that this
affects the default settings for the flash hook signal used by the system. For more
details, see Adjusting the flash hook timers on page 39.

d. Click Save.

e. The new system configuration opens in IP Office Manager.

3. From the navigation pane, select ®=/ System.
4. Select the Telephony tab and then the Telephony sub-tab.

a. Set the Dial Delay Time (sec) to 4 seconds.

b. Set the Dial Delay Count to 15.

c. Switch the Inhibit Off-Switch Forward/Transfer setting off.
5. Select the Voicemail tab.

Set the Voicemail Type to <None>.
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Adding IP Office licenses

6. Click the [z icon.
Next steps
» Go to Adding IP Office licenses on page 23.

Related links
Configuring the IP Office system on page 20

Adding IP Office licenses

You only need to follow this process if you are using a local PRI line for emergency calls and want
to license additional PRI call channels above the default 8 per PRI port. Otherwise, go to Adding
the ACO certificates on page 24.

The file is a single .xml file containing all the system licenses. These are issued against the serial
number of the system's Avaya System SD card.

Procedure
1. Load the IP Office configuration in IP Office Manager.
2. From the navigation pane, select Q}., License.

(] Avaya IP Office Manager System B [11.1.2.3.0 build 33] [Administrator(Administrator)]

File Edit View Jools Help
System B ~ Licence A vl = 2 ‘E
IP Offices Licence 5 v | <|>
..... j! BOOTP (25) Licence Type  Status Licence Remote Server
----- {# Operator (3)
[=-557 System B Licence Mode Licence Mormal
a7 System (1)
-7 Line () Licensed Version 11.0
-+ Control Unit (3)
-4 Extension (16) PLDS Host ID 111301183063
& User (18
% G::L; (1)1 PLDS File Status  Valid
3% Short Code (39)
@ Service (0) Feature Instances Status Expiry Date Source
ol RAS (1
% Incor('n?ng Call Route ACO System 1 Valid Mever Virtual
-8} WanPort (0) ACO Endpoints 384 Valid MNever Virtual
- Directory (0) SIP Trunk Channels 10 Dormant Mever PLDS Mod
£ Time Profile (0) IP500 Universal PRI (Additional cha... 10 Valid Never PLDS Mod|
{8} Firewall Profile (1)
El P Route (1)
-l Account Code (0]
B Licence )

» When configured as an IP Office ACO ATA Gateway system, the IP Office shows two
virtual licenses:ACO System and ACO User.

* If the system already had a license file loaded, any other licenses, except IP500
Universal PRI (Additional channels), should appear as Dormant or Obsolete.

3. Click Add and select the license .xml file for the system.
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Configuring the IP Office system

4. |P Office Manager lists the licenses in the file. However, at this stage the reported status of
the new licenses is incorrect.

5. Click File > Close Configuration and then reload the configuration.

6. From the navigation pane, select ’;., License again.
7. Check the status of the licenses.
* The ACO System and ACO User licenses should appear as Virtual.

» Any optional IP500 Universal PRI (Additional channels) license should appear as
Valid.

* All other licenses should appear as Dormant or Obsolete.
Next steps
* Go to Adding the ACO certificates on page 24.

Related links
Configuring the IP Office system on page 20

Adding the ACO certificates

The following process uploads the certificates needed for TLS connection to Avaya Cloud Office™
(see Downloading the ACO certificates on page 19).

A Warning:

* This process causes IP500 V2A operation to slow for a minute and end any calls
currently in progress.

Procedure
1. Load the IP Office configuration in IP Office Manager.
2. Select File > Advanced > Security Settings.

3. From the navigation pane, select =/ System.
4. Click on the Certificates tab.
5. In the Trusted Certificate Store section:
a. Click Add.
. Select Import Certificate from file and click OK.

b

c. Note the warning and click OK.

d. Select the intermediate certificate file and click OK.
e

. Repeat the process for the root certificate file.
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Configuring the local lines

6. Click OK.
7. Click the icon.
8. Select File > Configuration to return to normal configuration editing.
Next steps
» Go to Configuring the local lines on page 25.

Related links
Configuring the IP Office system on page 20

Configuring the local lines

This document does not cover the configuration of the local IP Office line(s) other than the ACO
line. For details of configuring other types of line, refer to the Deploying an IP500 V2 IP Office
Essential Edition System manual.

Procedure

1. Ensure that any trunk ports not used are set as Out of Service. You can do this using the
Line > Admin Setting setting.

2. For digital trunks, ensure that the number of channels configured matches those licensed
and provided by the line provider. Depending on the trunk type, you can do this using a
'number of channels' settings or a channel specific status setting.

Next steps
» Go to Adding the ACO line on page 25.

Related links
Configuring the IP Office system on page 20

Adding the ACO line

This document does not cover the configuration of other equipment such as the customer network,
firewalls, and any SBC equipment.

You need to configure the line using the user details obtained from Avaya Cloud Office™ (see
Setting up the ACO user phone details on page 17).

This process covers adding a new ACO line to the IP Office system configuration for calls to/from
Avaya Cloud Office™. The IP Office only requires a single ACO line.

Procedure

1. Load the IP Office configuration in IP Office Manager.
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Configuring the IP Office system

2. Click 1 1 Line in the navigate pane. Click the icon and select ACO Line.
3. Select the ACO tab:

ACO  WolP  T38 Fax

Line Number 7 = In Service

ACO Domain Mame |5ip.ringcentra|.com |

ACO Proxy Address |5ip30.ringcentra|.c0m |

Outgoing Group ID |96666

URI Type SIP URI -
Location Cloud ~
Metwork Configuration
Layer 4 Protocol TLS Send Port

Usze Network Topelogy Info | None w Listen Port | 3061

» Use the values obtained when setting up the ACO user phone details to configure the
ACO line:

ACO Value IP Office Line Value

SIP Domain ACO Line > ACO > ACO Domain Name without the port number.

Outbound proxy | ACO Line > ACO > ACO Proxy Address without the port number.

Note the Line Number. You need to use this value to create an incoming call route for
calls from Avaya Cloud Office™. Change the value if required.

Set the Use Network Topology Info setting to match the requirements of the customer's
network and internet connection:

* None - The system determines routing for the line using address matches in the IP
Office system's routing tables.

* LAN1TLAN2 - Use the matching LAN's System > LAN1 > Network Topology settings.
Select the VoIP tab. Check that the settings match the following defaults.

7. Select the T38 Fax tab. Check that the tab is set to Use Default Values.

8.

Click the .i-‘ icon.

Next steps
* Go to Edit the system short codes on page 27.

Related links
Configuring the IP Office system on page 20
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Edit the system short codes

Edit the system short codes

The system short codes need 2 major changes:

* Remove all system short codes for IP Office features. Avaya do not support those features
for an IP Office in IP Office ACO ATA Gateway mode.

» Add an emergency short code(s) for emergency numbers.
* Note: IP Office ACO ATA Gateway mode does not support user short codes.
Procedure

1. Load the IP Office configuration in IP Office Manager.

2. From the navigation pane, select 9* Short Code.
3. Delete the default system short codes:
a. Use the Group Pane (View > Group Pane).
b. Select and highlight all the existing short codes.
c. Right-click on the short codes and select Delete.

4. Add an outgoing calls short code:

Edit Short Code
Code |? |
Feature Dial W

Telephone Mumber | |

Line Group ID | 50 v|

Click the icon and select Short Code.

Set the Code to ?

Set the Feature to Dial.

In the Telephone Number field, enter a . (a full-stop or period).
Set the Line Group ID to 50.

Click OK.

5. Click OK.

-~ ® o o T o

6. Click the [z icon.

Next steps
» Go to Edit the outgoing automatic call route selection (ARS) on page 28.

Related links
Configuring the IP Office system on page 20
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Configuring the IP Office system

Edit the outgoing automatic call route selection (ARS)

The system short code routes all dialing to the matching IP Office automatic route selection (ARS).
The ARS is configured with additional short codes that set where numbers are routed.

Procedure
1. Load the IP Office configuration in IP Office Manager.
2. From the navigation pane, select ARS.
3. Select the ARS called Main.
4

. Add an Outgoing Calls Short Code: This short code routes all dialing, other than
emergency calls, to the ACO line.

a. Click the icon and select Short Code.
b. Setthe Code to N; The ; (semi-colon) is important for correct operation.
c. Set the Feature to Dial.
d. In the Telephone Number field, enter an N.
e. Set the Line Group ID to 96666.
f. Click OK.
5. Add an Emergency Call Short Code:
a. Click the icon and select Short Code.
Set the Code to 911.
Set the Feature to Dial Emergency.

In the Telephone Number field, enter 911.

© o o ©

Set the Line Group ID as follows:
* If using the ACO emergency service, set the Line Group ID to 96666.

* If using a local IP Office emergency line, set the Line Group ID to match the
Outgoing Group setting of that line.

f. Click OK.
6. Repeat the process for any other emergency numbers required.
7. Click OK.

8. Click the = icon.

Next steps
* Go to Create a PSAP callback hunt group on page 29.

Related links
Configuring the IP Office system on page 20
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Create a PSAP callback hunt group

Create a PSAP callback hunt group

When using a local emergency trunk, this process allows the emergency public service access
point (PSAP) to make return calls. For example, when a caller to the PSAP unexpectedly
disconnects. To achieve this:

» Create an emergency hunt group containing extensions staffed during normal business
hours.

» Create an incoming call route from the line used for outgoing emergency calls. Configured
the group as the destination.

Procedure
1. Load the IP Office configuration in IP Office Manager.
2. Create an emergency callback group: The group should contain user extensions staffed
during normal business hours.
From the navigation pane, select s’@ Group.
Click on the existing group "Main".
Change the Name to match group's function. For example, "Emergency".
Check that the Ring Mode is set to Collective.

Edit the list of users: By default, the system automatically adds the first 16 extensions
to the group. However, these may not match the require extension users for
emergency callback calls.

a. In the User List, click Edit.
b. Edit the list of users as needed.
c. Click OK.

f. Click OK.

3. Route calls to the emergency callback group: From the navigation pane, select Incoming
Call Route.

® 2 0o T o

a. Click the 1 icon and select @ Incoming Call Route.

b. On the Standard tab, use the Line Group ID to select the Incoming Group value
used for the local emergency trunk(s).

c. Select the Destinations tab.

d. For the Destination and Fallback Extension settings, select the emergency callback
group.
e. Click OK.

4. Click the [z icon.
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Configuring the IP Office system

Next steps

» Go to Configuring the IP Office ACO users on page 31.

Related links

Configuring the IP Office system on page 20
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Chapter 5: Configuring the IP Office ACO
users

The processes in this section configure the IP Office analog extension users.

Related links
Configuring the IP Office ACO users on page 31
Configuring the IP Office ACO extensions on page 32
Configuring incoming call routing on page 33
Checking ACO registration on page 34
Testing operation on page 35

Configuring the IP Office ACO users

When first started, the IP Office system automatically creates user and extension entries for
each extension port. For the analog extension ports, use the following process to configure the
extensions associated user as an ACO extension user.

You need to configure each user using the user details obtained from Avaya Cloud Office™ (see
Setting up the ACO user phone details on page 17).

© Important:

* You must reboot the system after any changes to any ACO extension, user or line
settings. You must do this even if IP Office Manager indicates that the changes are
mergeable.

Procedure

1. Load the IP Office configuration in IP Office Manager.

2. From the navigation pane, select ﬁ User.
3. Select the required user.
4. Select the User tab:
a. Set the user's User Profile to ACO User.

b. Set the user's Name, Authentication Name, Password and Extension values to
match those provided for the user by Avaya Cloud Office™.
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Configuring the IP Office ACO users

ACO Value IP Office User/Extension Value
Username User > User > User Name

User > User > Extension

Extension > Extension > Base Extension

Password User > User > Password

Authorization User > User > Authentication Name
ID

« |P Office Manager display warnings regarding the password length not matching
the IP Office system requirements. Ignore those warnings.

c. Click OK.

5. Delete all other users not used for Avaya Cloud Office™ extension. Avaya does not support
them in IP Office ACO ATA Gateway mode and removing them helps simplify system
maintenance. See Other phones and extensions on page 13.

6. Repeat the process for the next user extension.

7. Click the =l icon.
Next steps
» Go to Configuring the IP Office ACO extensions on page 32.

Related links
Configuring the IP Office ACO users on page 31

Configuring the IP Office ACO extensions

You need to change the extension number associated with each analog extension to match the
ACO user's number.

» Other extensions: The IP Office automatically creates an extensions entry for each physical
extension ports. Those extensions not used as ACO extensions cannot be deleted but are
not supported on an IP Office system in IP Office ACO ATA Gateway mode. See Other
phones and extensions on page 13.

© Important:

* You must reboot the system after any changes to any ACO extension, user or line
settings. You must do this even if IP Office Manager indicates that the changes are
mergeable.

Procedure
1. Load the IP Office configuration in IP Office Manager.

2. From the navigation pane, select € Extension.
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Configuring incoming call routing

3. Select the required analog extension.
4. Select the Extension tab.

5. Change the Base Extension to match the ACO user's number.

ACO Value IP Office User/Extension Value
Username User > User > User Name

User > User > Extension

Extension > Extension > Base Extension

Password User > User > Password

Authorization ID | User > User > Authentication Name

6. Select the Analog tab.

a. Check that the Equipment Classification is set to Standard Telephone. That
includes extensions used for fax machines.

b. Check the Flash Hook Pulse Width is set to Use System Defaults. This matches
the default settings for the system's configured Locale. See Adjusting the Flash Hook
Timers on page 39 for more details.

7. Repeat the process for the next user extension.

8. Click the = icon.
Next steps
» Go to Configuring incoming call routing on page 33.

Related links
Configuring the IP Office ACO users on page 31

Configuring incoming call routing

You need to add an incoming call route for calls from Avaya Cloud Office™.

Procedure
1. Load the IP Office configuration in IP Office Manager.

2. From the navigation pane, select @ Incoming Call Route.

a. Click the _1 icon and select Incoming Call Route.
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Configuring the IP Office ACO users

b. On the Standard tab, for the Line Group ID , manually enter the Line Number
shown in the configuration for the ACO Line.

Standard  Voice Recording  Destinations

Bearer Capabhility Any Voice ~

Line Group ID 17 v

Incoming Sub Address |

|
Incaming Mumber | |
|
Incoming CLI | |

c. Select the Destinations tab.

d. For the Destination and Fallback Extension settings, enter . (a period or full-stop).

Standard Voice Recording Destinations

TimeProfile Destination Fallback Extension
3 Default Value . w . w

e. Click OK.

3. Click the H icon.
Next steps

» Go to Checking ACO registration on page 34.

Related links
Configuring the |P Office ACO users on page 31

Checking ACO registration

Using the System Status Application, you can view the status of the user's registrations with
Avaya Cloud Office™.

i Avaya IP Office System Status - IPOffice_137 (10.133.134.137) - IP500 V2 11.1.2.3.0 build 22

AVAYA

IP Office System Status

Help Snapshot LogOff Exit About

Status  Utilization Summary  Alarms = Registration
IT Registration Status
4
User Name

Lis 9
Line: 10 1 [ 13326007498 | Registered
Lo 2 [ 13323342394 | Registered

B r

L
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Testing operation

Procedure

. Connect to the IP Office system using System Status Application.

Expand the Trunks list and select the trunk number that matches the ACO line.

. Select the Registration tab. The tab displays the status of each user's registration to

Avaya Cloud Office™.

If the tab show issues for some users, check their user settings. If the tab shows issues for
all users, check the ACO line settings.

Next steps

» Go to Testing operation on page 35.

Related links
Configuring the IP Office ACO users on page 31

Testing operation

Test call operation.

Procedure

1.

o e DN

Test calls between the Avaya Cloud Office™ users. The calls should route to Avaya Cloud
Office™ and then back to the IP Office and the called Avaya Cloud Office™ user.

Test calls from Avaya Cloud Office™ extensions to an external PSTN number.
Test calls from an external PSTN number to the Avaya Cloud Office™ extensions.
Test that the system blocks calls to IP Office features.

Using the locally allowed protocol, make test emergency calls.

* If the PSAP allows test calls using the emergency call numbers, do not end the calls
without informing the PSAP responder that the call is a test.

» Some PSAP providers support an emergency call test number. When called, an
automated response announces the address the PSAP has on record for the calling
number. Where supported, configure the test number in the IP Office configuration to
use the same call routing as the emergency numbers.

- The Avaya Cloud Office™ E911 emergency service supports using 933 as an
emergency call test number.

Related links
Configuring the IP Office ACO users on page 31
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Chapter 6: Additional information

You need to be aware of how the analog extensions operate when using the IP Office system as an
Avaya Cloud Office " gateway.
Related links
Known issues on page 36
Limitations on page 37
Local IP Office call handling on page 37
Avaya Cloud Office feature codes on page 38
Adjusting the flash hook timers on page 39
Fax configuration on page 40
Upgrading from IP Office R11.1 FP2 SP2 on page 40

Known issues

The following known issues existed at the time of publication:

Issue Description

Reboot Required You must reboot the system after any changes to any ACO extension, user or line
settings. You must do this even if IP Office Manager indicates that the changes are

mergeable.
Audio issues During long duration Avaya Cloud Office™ calls, if the user holds the call, when unheld
the speech path is not always reestablished correctly.
Call transfer — When an Avaya Cloud Office™ extension user makes a blind call transfer, they should
Blind transfer wait for 5 seconds after dialing the transfer target before hanging up. This allows for the

time that the IP Office and Avaya Cloud Office” need for call routing. If the user drops
the call too soon after dialing the transfer number, the call transfer may fail.

Voicemail Message | Avaya Cloud Office” does not provide message waiting indication (MWI) to the IP Office
Waiting Indication | extensions.

Related links
Additional information on page 36
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Limitations

Limitations

In addition to the known issues, the following key limitations apply to the operation of the IP Office
system when configured as an IP Office ACO ATA Gateway.

Limitation

Description

Call waiting tone

When call waiting is enabled on the user, the user only hears a single non-repeated tone
to indicate a second incoming call.

Unplugged After unplugging an analog extension, the IP Office system may still have an active

Extensions Avaya Cloud Office™ registration for the extension. When that occurs, Avaya Cloud
Office™ still attempts to route calls to the extension rather than to the extension's Avaya
Cloud Office™ voicemail.

User Short Codes | IP Office systems in IP Office ACO ATA Gateway IP Office ACO ATA Gateway do not

support user short codes.

Extensions and
User Auto-Creation

For an existing system being reconfigured as an IP Office ACO ATA Gateway, re-running
the initial configuration recreates a user for each physical extension port even if those
users have previously been deleted.

Related links

Additional information on page 36

Local IP Office call handling

Analog telephones use the recall button to perform actions such as transfer, hold, unhold, answer
call waiting. The button is known as the Recall, Flash or Hook Flash button and marked R, F or
H respectively depending on the phone model.

» When using the recall button, the IP Office performs the call handling, not Avaya Cloud

Office™.

* For example: During a call, pressing recall places that call on hold on the IP Office system.
Pressing recall again reconnects the call.

Whilst this does not prevent the use of recall functions on the analog extensions, you need to be
aware of the following caveats:

» The dial tone heard when the analog extension user presses the recall button is local dial
tone from the IP Office.

* If during an existing call the user hears call waiting tones, they can press the recall button to
switch between their current call and the waiting call.

* When the analog e>T<Mtension user presses recall during a current call, the existing call to/from
Avaya Cloud Office " remains connected to the IP Office. The caller hears the IP Office
music-on-hold (by default a double-tone every 4 seconds).
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Additional information

* When transferring calls using the recall button, the IP Office performs the transfer. To allow
this:
- You must disable both the IP Office user and system Inhibit Off-Switch Forward/Transfer
settings.

- User trying to perform an unsupervised/blind transfer should wait at 5 seconds after
entering the transfer number before hanging up. This is necessary to allow both IP Office
and Avaya Cloud Office™ call routing to complete. See Known issues on page 36.
Related links
Additional information on page 36

Avaya Cloud Office™ feature codes

For non-emergency calls, the IP Office sends all digits to Avaya Cloud Office™ as DTMF. The
following table lists some of the Avaya Cloud Office ™ feature codes that users may be able to use.
However, Avaya Cloud Office™ controls which features codes it supports for analog phones. For
more details, refer to https://onecare.avaya.com/AvayaCloudOffice/kb/public/DOCS100771.

Feature ACO Feature Code Description

Open the ACO * When calling your extension or Direct Number,

Interactive Menu press * to manage your Avaya Cloud Office account
settings.

Call Flip *<Flip Number> During an active call, press *1 up to 8 to start call
flip.

Call Recording *9 During an active call, press *9 to start or end call
recording.

Caller ID Block *67<10-Digit When placing an outgoing call, dial *67 before the

Number> 10-digit number to block your outgoing caller ID on

the call.

Intercom Call *85<Ext Number> Dial *85 to make an intercom call. For example:

*85102 for extension 102.

Analog extensions cannot receive intercom calls.

Voicemail *86 Dial *86 to listen to your voicemail messages.
Avaya Cloud Office™ does not provide message
waiting indication.

Call Park ##*3 Press ##*3 to park an active call.

Note: For calls between Avaya Cloud Office™ users,
the caller cannot park the call using this code. The
called user can park the call.

Call Park Retrieve *<Park Location> Press * and then the Park Location to pick up a
parked call.

Table continues...
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Adjusting the flash hook timers

Feature ACO Feature Code Description

Call Return *69 Initiate an outgoing call to the last incoming call in
your call log.

Hold #HH Press ## to place an active call on hold.

Note: For calls between Avaya Cloud Office™ users,
the caller cannot hold the call using this code. The
called user can hold the call.

External Transfer ##*1<10-Digit Note that transfers shown the original caller's ID,
Number> not that of the extension transferring the call.
Internal Transfer ##<Ext Number>#
Page *84<Group Number># | Make an announcement to a group and hang up
when finished.
Mute Conference *#903# If you are the only participant on an Avaya Cloud
Bridge Music Office™ conferencing bridge, dialing this code mutes

the hold music.

Related links
Additional information on page 36

Adjusting the flash hook timers

Analog devices use a flash hook signal during a call to indicate when they need additional
services from the telephone system. For example, to put a call on hold or to transfer a call.

A flash hook signal is a short interruption in the call connection. Originally, analog telephone users
would send a flash hook signal by briefly tapping the hook switch on their phone. On most modern
phones, user can send a flash hook signal by pressing the key marked R, Recall, H, or Hold. The
marking varies between different makes and models of phone.

The minimum and maximum interruption time for a hook flash signal vary between countries. For
details of the different maximum and minimum width values used in various countries, refer to the
Avaya |IP Office Locale Settings manual.

For IP Office systems, you can adjust the settings to match local analog phones as follows:
Procedure

1. System Setting: The default settings for all analog extensions is set by the system's
System > System > Locale setting. This set the values to match the selected country.

2. Extension Setting: The Extension > Analog > Flash Hook Pulse Width setting for each
analog extension is set to either Use System Defaults (the default extension setting) or to
specific Minimum Width and Maximum Width values.

Related links
Additional information on page 36
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Additional information

Fax configuration

The solution supports the use of an analog fax machine. To do this:
Procedure
1. On the ACO line, set the Line > T38 Fax settings to Use Default Values.

2. On the fax extension's, set the Extension > Analog > Equipment Classification setting
to Standard Telephone.

Related links
Additional information on page 36

Upgrading from IP Office R11.1 FP2 SP2

Avaya previously supported IP Office to Avaya Cloud Office™ extensions using IP Office R11.1
FP2 SP2. However, to continue receiving support, those customers must upgrade to IP Office
R11.1.2.3. Do that using the following process.

Procedure

1. If using a SIP trunk for the local emergency trunk, install and test a replacement using an
analog, PRI or BRI trunk.

2. Upgrade the IP500 V2A from IP Office R11.1 FP2 SP2 to IP Office R11.1.2.3.

3. After running the initial IP Office configuration (see Running the initial IP Office
configuration utility on page 21), ensuring that the system reboots.

Related links
Additional information on page 36
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Chapter 7: Additional Help and
Documentation

The following pages provide sources for additional help.

Related links
Additional Manuals and User Guides on page 41
Getting Help on page 41
Finding an Avaya Business Partner on page 42
Additional IP_Office resources on page 42

Training on page 43

Additional Manuals and User Guides

The Avaya Documentation Center website contains user guides and manuals for Avaya products
including IP Office.

« For a listing of the current IP Office manuals and user guides, look at the Avaya IP Office™
Platform Manuals and User Guides document.

* The Avaya IP Office Knowledgebase and Avaya Support websites also provide access to the
IP Office technical manuals and users guides.

- Note that where possible these sites redirect users to the version of the document hosted
by the Avaya Documentation Center.

For other types of documents and other resources, visit the various Avaya websites (see
Additional IP_Office resources on page 42).

Related links
Additional Help and Documentation on page 41

Getting Help

Avaya sells IP Office through accredited business partners. Those business partners provide
direct support to their customers and can escalate issues to Avaya when necessary.
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Additional Help and Documentation

If your IP Office system currently does not have an Avaya business partner providing support and
maintenance for it, you can use the Avaya Partner Locator tool to find a business partner. See
Finding an Avaya Business Partner on page 42.

Related links
Additional Help and Documentation on page 41

Finding an Avaya Business Partner

If your IP Office system currently does not have an Avaya business partner providing support and
maintenance for it, you can use the Avaya Partner Locator tool to find a business partner.

Procedure

1. Using a browser, go to the Avaya Website at https://www.avaya.com

2. Select Partners and then Find a Partner.
3. Enter your location information.
4. For IP Office business partners, using the Filter, select Small/Medium Business.

Related links
Additional Help and Documentation on page 41

Additional IP Office resources

In addition to the documentation website (see Additional Manuals and User Guides on page 41),
there are a range of website that provide information about Avaya products and services including
IP Office.

« Avaya Website (https://www.avaya.com)

This is the official Avaya website. The front page also provides access to individual Avaya
websites for different regions and countries.

» Avaya Sales & Partner Portal (https://sales.avaya.com)

This is the official website for all Avaya business partners. The site requires registration for
a username and password. Once accessed, you can customize the portal to show specific
products and information type that you want to see.

» Avaya Support (https://support.avaya.com)

This site provide access to Avaya product software, documentation and other services for
Avaya product installers and maintainers.

- Avaya Support Forums (https://support.avaya.com/forums/index.php)

This site provides forums for discussing product issues.
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Training

* International Avaya User Group (https://www.iuag.org)

This is the organization for Avaya customers. It provides discussion groups and forums.

» Avaya Learning (https://www.avaya-learning.com/)

This site provides access to training courses and accreditation programs for Avaya products.

Related links
Additional Help and Documentation on page 41

Training

Avaya training and credentials ensure our Business Partners have the capabilities and skills to
successfully sell, implement, and support Avaya solutions and exceed customer expectations. The
following credentials are available:

» Avaya Certified Sales Specialist (APSS)
» Avaya Implementation Professional Specialist (AIPS)
» Avaya Certified Support Specialist (ACSS)
Credential maps are available on the Avaya Learning website.

Related links
Additional Help and Documentation on page 41
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